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Introduction 
 
This manual is intended as a help to people who are being introduced to the Sacramental 
Register program for the first time. It discusses concepts, advantages, applications, and it 
attempts to explain how to use the program. Please submit additional questions or suggestions 
regarding the documentation for the use of Sacramental Register to support@rpinet.com. 
 
 What are Sacramental Registers? 
 
Sacramental Registers are a set of official ledger books within which Roman Catholic parishes 
and other denominations record the details associated with Baptisms, First Communions, 
Confirmations, Marriages, Deaths, Professions of Faith, and the rite of Acceptance into the 
Catechumenate. These books are kept forever, and are supplemented with additional volumes as 
necessary so that, in a large parish, there can be a whole series of Baptism registers going back 
well into the past. Generally, sacramental records are entered into these books in chronological 
order, as the events occur. As people grow and move around, the practice is to send a 
notification to the church of Baptism whenever a person is confirmed, receives first 
communion, or is married. These notifications must be logged in the Baptism registry, in the 
entry for the individual involved. The notifications must also be acknowledged with a reply that 
verifies that the notification has been received. 
 
 What is Sacramental Register and Certificate Maker 4.0, and what does it do? 
 
Sacramental Register and Certificate Maker 4.0 is a Windows software solution which can either 
replace or supplement the bound register books. Using Sacramental Register offers the following 
advantages to users: 
1. People entered in the program's data file are kept in last name order, so that searches are 
instantaneous. With the books, you have to hunt through the volumes chronologically, which 
takes more time. 
2. All sacramental information is accessible from the person's datafile entry. With the books, 
except for the Baptism registry, each sacrament is entered separately in its proper volume, with 
no reference to other entries in other volumes. 
3. A basic certificate can be previewed and printed for any sacrament that a person has received 
with a few clicks. Without Sacramental Register, a certificate form has to be filled out manually. 
4. Sets of certificates (for, say, a Confirmation class) can be previewed and printed out in a group 
with Sacramental Register. 
5. Sacramental Register has special ledger reports which can be printed out for any time interval, 
such as one day, one month, or one year for example. These reports can be filed to simulate 
printed register volumes, or they can be transmitted to the diocese to report on all the deaths 
registered in the past year, for example. 
 
 What other documentation is available for Sacramental Register? 
 
There is an extensive Help file which installs with Sacramental Register. This file can be accessed 
from the program Help menu, or it can be accessed independently by double clicking on the 
Help file in the folder where Sacramental Register is installed. 
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In addition, there are frequently asked questions at www.rpinet.com/sr4faqs.html. These 
questions are updated from time to time, and users need to check there to see if any issues have 
risen or if any problems have been encountered and fixed. 
 
 How do I learn how to use Sacramental Register? 
 
You can find ideas in the Help file, or in the FAQs, or in this manual. Basically, we have 
attempted to make a fairly intuitive tool for parishes to use, without hours of study and without 
a steep learning curve. Fundamentally, Sacramental Register is used to enter sacrament reception 
data for people, and it is also used to generate certificates, parish notifications, and special 
reports. Here are the basic things you have to understand to have a good experience with 
Sacramental Register and Certificate Maker.  
 
Your master data file 
 
All the data for your records is kept in a file system called a database, which consists of a set of 
data files. These data files are all related to one another, and are accessed as a group through the 
SacReg program interface. There are seventeen total files in a file set or database, but 
Sacramental Register lets you refer to the set of files by one file name, for convenience. In this 
document, we sometimes refer to a file set, sometimes a database, and sometimes to a file, but 
no matter which term we are using, we are referring to the seventeen file set that constitutes 
your database or master data file. 
 
 How to create a new data file 
 
From the main screen, click on the File menu to drop down the list of options. Select "Create a 
new set of data files." When you do this, the program will display what is called an Open Dialog 
Box, and it will permit you to change the "look in" folder. You can browse to an existing folder, 
or you can create a new  folder. You can also browse to a specific folder AND create a new 
folder subordinate to the one you browsed to. You should always attempt to keep a set of 
Sacramental Register data files all together in a folder with no other files in it. Once you have 
selected or created an empty folder, whose name is appearing in the Look in window, then, 
below the large window, you are ready to enter the name of the new set of files. The name can 
be anything you like, but there are some restrictions. The file set name must end with the 
characters 0.adt. (That is a zero followed by a period followed by the letters adt.) So, for 
example, you can create a file set with the name X0.adt, or HolyCross0.adt, or 
JoansMarch07Data0.adt. We recommend no spaces, and no special characters in the file names. 
Once you have the file name entered in the file name box, click on the Open button in the 
Open Dialog Box. This will create your new set of seventeen data files, and you will be ready to 
start entering data. 
 
 How to open a previously created data file set 
 
Once a file set has been created, some data has been entered into it, and the file has been closed, 
then it can be opened by launching the SacReg program, clicking on the File menu, and clicking 
again on the selection below the line under the Exit option. That area lists the last few data files 
that have been opened, and the path to the files. The first time you open a file, it may be 
necessary to click on Open Existing Data File from the File menu, and then browse to the folder 
and file name that you wish to open. You can use this method every time you open an existing 
file, but most users appreciate the program remembering the last few files and permitting them 
to be opened by clicking on the path at the bottom of the file menu. 
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 How to check the integrity of the data file set 
 
At any time, you may wish to verify that your data file has no problems with inaccessible 
records, or data corruption. There is a little onscreen report which can be run to check the data 
file. Click on the Output menu, and toward the bottom, click on Count the entries in this 
database. That brings up a little screen with a rather large button on it. Clicking on that button 
causes the program to run through the entire data file, reading every record in the data file, and 
every record referred to by entries in the data file. If a record is not accessible, a message is 
displayed. If you receive large numbers of messages from this report, something has run amuck 
with your data files, and you will probably need to revert to a backup copy. Backups are a critical 
user responsibility and are discussed a little later on. 
 
Part 1. Entering People in the data file 
 
Now that you have a new file open, or an existing file open, you can begin to put people in the 
file. Whether you begin with the first entry in the oldest register book, or you begin with the 
next person who is to be baptized in your parish, the process is the same. 
 
 How to add a new person to the file 
 
Click on the button near the top left of the screen reading Enter/Edit data. That switches the 
screen to the Master/Detail view, which shows the general information about the person. If you 
are working with your very first entry, this screen should be all empty of values.  If you have 
entered only a small number of people, and you believe you do not need to look the person up 
to avoid making a duplicate entry, the master detail information will be showing information for 
another person. Click on the Create New Entry button. This will insert a blank entry, and will 
clear all the data fields so you can enter the information for your new person.  
 
If you have other names entered already, and especially if you have hundreds or thousands of 
people entered already, then it is a good idea to begin by "looking up" the person to be sure they 
have not already been entered in the file. To look up someone, click on the Look Up Data 
button. This changes to the Search screen. In the upper right area of this screen is a long data 
field, into which you can enter the person's name, beginning with the last name followed by a 
comma and a space and then the first name. If necessary, you can enter another space and type 
the baptism date in the format mm/dd/yyyy (such as 02/29/2004). As you type the last name, 
the grid should begin to display names that are closer and closer to the person you are entering. 
If you spot that the person is already in the list, you can double click on the person's name to 
show the master/detail view of the information about the person. Obviously, if the person has 
already been entered in the file, you will want to update the entry already present rather than 
create a duplicate entry. 
 
 Last Name, First Name, Date of Baptism (required information). 
 
When you do enter a new person in the data file, it is important that you enter three pieces of 
information at a minimum. You must enter the person's last name, first name, and date of 
baptism. These three pieces of information are used to create the unique reference for the 
person in the database. These three pieces of information should be entered before the data is 
saved. You can enter any other information that you wish, but each time, the entry should begin 
with these three pieces of information. 
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What if you have no date of baptism? What if the person has never been baptized? What if I 
leave the date blank?  We recommend that you identify a date that you use for each of these 
cases. If you do leave the date blank, the program will save your entry using the date 
12/31/1899. This is ok, but it is better to obtain the correct date, or to assign a date that you 
have chosen to represent each of the different cases that arise. 
 
 Sacrament Details 
 
Once the basic information for a person is entered, it is time to click on the appropriate 
sacrament button to enter the details specific to that sacrament. For example, if you are entering 
data from Baptism registers, you would click on the Baptism button. This displays a screen on 
which the details of the baptism can be entered. If parish notifications have been received and 
noted in the printed register, those, too, can be entered on this screen. When the details have 
been entered, then you can click on the OK button at the bottom of this screen. Doing so will 
close this screen and return you to the master/detail screen. If you have other information about 
the individual and specific sacraments confered in your parish, then you can click on additional 
sacrament detail buttons until you have entered everything you know about this person. When 
you are finished, you can click on the Create New Entry button to begin entering the next 
person. 
 
 How to change an entry in the data file. 
 
If, at any point, you see that one of the data values is incorrect, you can simply click in that data 
field, and type the correct information. If you change something on the master/detail screen, 
and you do not, at the same time change one of the sacrament details, then it is important that 
you "post" the changed data value before doing anything else (before leaving that screen). To 
post the data on the screen to the file, you should look along the little row of symbols on the top 
right part of the screen. These symbols constitute a navigator bar, and they can be used, 
generally, to step through the entries in the file. One of the symbols, a check mark, can be used 
to post the current data to the file. If this checkmark is black, then the data has been changed on 
this screen. If the change was intentional, then click on the checkmark. It will turn gray, 
indicating that the data in the file agrees with the data on the screen. If you click on one of the 
sacrament buttons, the program automatically posts the master/detail data on the screen into the 
file. 
 
 How to delete entries from the data file. 
 
Because deleting is a dangerous capability, we have made it so that deletions must be intentional. 
There is a Delete Record button on the screen, but it is gray (disabled). If you have come across 
a duplicate entry or a wrong entry and you wish to delete that entry, then search the entry so that 
the entry to be deleted is selected and showing on the master/detail screen. Then click on 
Options on the menu, and select Enable Delete Button in the drop-down list. This enables the 
delete button. Clicking on the delete button will delete the record currently displayed in the 
master/detail view. Clicking on the delete button will also disable the delete button, so that you 
can't accidentally delete two entries. Each time a deletion is done, this process must be repeated. 
 
Entering LOTS of people in the data file 
 
Some parishes, which were founded 100 years ago, or 200 years ago, have many handwritten 
register books to enter. They recruit volunteers to enter their data. Sacramental Register has 
been designed for this sort of data entry approach. Specifically, the parish license fee permits the 
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program to be installed on as many computers as is necessary, provided they are all in the same 
parish. Each data entry volunteer, after proper training in your offices, can proceed as follows: 
1. Create a new data file, such as JohnDoe1945data0.adt 
2. Enter data for all (or some) of the people in the register book, including sacramental details. 
3. When enough data has been entered to make sense (usually a few hundred names or so), the 
seventeen data files that make up the database can be copied to a Zip Disk, or burned onto a 
CD, or even emailed so as to get the files to the person who is handling the parish master data 
file. 
 
 Multiple data input stations 
 
4. This approach permits several people to input data, on their own machine, and on their own 
schedule, and it permits the data files created in this way to be gathered and imported to create 
and build a substantial parish master data file. 
 
 Importing data files into the master data file  
 
5. The person handling the master data file can, with the master file open, import the data from 
each data entry volunteer. The function for importing data from other files is accessible on the 
File menu. The import process will look for duplications as it imports the data. If it encounters a 
duplicate, it updates the existing record rather than importing a duplicate record. Because this 
data entry process results in a physical backup of the data files, it is not a bad way to proceed 
even if you only have one person doing everything. 
 
Obviously, this approach to building a database requires some organizing, some training, and 
some experience entering the data. It also requires that the "main" person be familiar with data 
file sets, and have a process or plan which clearly distinguishes between the parish master data 
file and any and all files submitted for importation. For example, if the parish master data file is 
HolyCross0.adt, then you don't want any volunteer to create a data file with that very name, 
because it would create possible confusion when it came time to import the data file into the 
master file. If they both have the same name, then it would be possible to open the data entry 
data files and import the master file into it! Perhaps no harm done, but it would create a 
confusing situation. 
 
Back up your master data file 
 
The single most important user responsibility with Sacramental Register 4.0 is that of making 
backups and managing backups. Please see the program Help file for more information about 
backups. Briefly, SacReg permits you to open and work with files in much the same way as you 
would use a word processor to open and work with a document. But... There is an enormous 
difference between your parish master database and "a document". There are not very many 
documents which are large enough or critical enough to create a disaster if the file becomes 
corrupt or gets lost or accidentally erased. Even a fairly long document can be typed in 
completely in just a few hours. 
 
But consider your parish master database. Every single day that you add a new person's data to 
the master file, it becomes more unique and comprehensive. If you do not make regular 
backups, then you are asking for trouble. Trouble can come from mother nature (a fire, flood, or 
earthquake), the housekeeper (accidently pulling the plug), an equipment failure, an operator 
“oops,” or a well-meaning “I cleaned off some files on your computer to give you more hard 
drive space!” There is nothing quite so vulnerable as a database file that is not backed up, and 
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preferably backed up on other media or other systems. Backups should be made as often as is 
necessary so as to not create an overwhelming task of re-creation, if the need arises to use a 
backup, and re-enter all the data that has been entered since the last backup was made and 
saved. If you are furiously entering data all day long, then making a backup a couple of times 
each day would not be a bad idea. If you have all your data entered, and you are entering a 
couple of dozen new people a week, then making a backup once a week seems defensible. The 
backup plan should include a way to keep backups for several weeks, just in case “something 
happens” to the most recent backup at the moment when it is needed. It is also very important 
to make sure you are not backing up a corrupt file, and that the backup itself is created properly 
and can be opened. 
 
 How to verify the datafile integrity before making a backup 
 
With the master data file open, go to the Output menu item, and select Count the entries in this 
database. On the screen that appears, click on the large button to Count the entries in the 
datafile. This report goes through the entire file, making sure that every record is present and 
readable.  This report should be run prior to making a backup. After a backup is created, it 
should be opened with the program, and this report should be run on the backup too. Any error 
messages that occur while this report is being created should be investigated. 
 
 How to create a backup 
 
With the program running, and the master data file open, go to the file menu and select Back up 
a set of files. This displays a Save Dialog screen, which has a Save in field which probably points 
to the installation folder (4.0). Browse to the hard drive location where you would like to save 
the backup, and then enter a name for your backup file. For example, HolyCrossBackup0.adt, or 
another name that makes good sense to you. Please make the backup to a hard drive folder. 
Once the backup has been created and checked, it can be copied onto another medium or to 
another system. We have had annoying problems with efforts to back up the master data files to 
a diskette (normally a diskette is too small for the data files), or to a CD (often requires special 
CD writing software).  
 
It is, of course, possible to simply locate and copy the folder in which your master file is kept in 
order to make a backup from outside the program. Also, some places have special backup 
programs, and even backup hardware such as cartridge tape drives for this purpose. These 
approaches can be used to do your backups, especially if a multiple copy process is already in 
place for that device. However, we recommend that the data which is backed up be “restored” 
to a hard drive folder and then opened and exercised (run Count the entries, etc.) before trusting 
that the backup is being made correctly. Automatic backup should never be the ONLY backup! 
 
 Where to save a backup 
 
After making the backup to a folder on your hard drive, and verifying that the database was 
backed up correctly (see below), you should migrate the backup so that it is saved on a different 
hard drive than the master is kept on, and/or it should be saved on a ZIP or CD media, or a 
flash drive (or jump drive). Again, the idea is to have enough backups that you do not have to 
worry about all the little things that can go wrong with any single copy of the master data file. 
ZIP or rewritable CDs or Jump drives seem particularly suited to this task, since they can be 
rotated in a five or six backup cycle, so that when you copy your newest backup on the oldest 
disk or CD, you still have five recent backups to fall back on. If you do use this sort of 
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approach, be sure you change media every so often, so that wear and tear, or scratches don't 
undermine your backup process. 
 
 How to verify that the backup was correctly done. 
 
The SacReg program should report errors encountered in attempting to create a backup. If no 
errors are reported, and the message displays that says the backup was successful, then you have 
a good chance of having the backup be correct. But the best way to verify any data file set, is to 
restore it to a hard drive folder, and then use the SacReg program to open the backup data files. 
If Count the entries runs to completion without error, then the backup is a true backup. 
 
Part 2. Finding people in the data file 
 
Looking up people in the master file is probably the most frequently performed operation that 
SacReg is used for. It can be used while doing data entry, as described elsewhere, to minimize 
the chance for duplicate entries, and it can be used when someone contacts the parish for a copy 
of their baptism certificate. 
 
 Searching by name 
 
Most commonly, the data will be searched by name. The Name Index is the default index, and 
you don't need to change to a different index unless it becomes necessary to search the data by 
one or another sacrament date. That is the assumption made in developing the program. When 
searching by for a person by name, you must enter the last name followed by a comma and a 
space, and then the first name. If there are several people with the same first and last names, 
then you must enter the date of baptism, in the format mm/dd/yyyy. You should not find 
duplicate entries with the same exact name and baptism date. If you do find duplicate entries, 
they probably are duplicates, and should be consolidated into a single entry. Once you find the 
proper person, whether or not you are finished typing in their name, etc., you can double click 
on their name in the grid display, and the master/detail view will appear showing their 
information. 
 
 Searching by Sacrament date 
 
If you don't have the person's name, or you don't know the spelling, but you do know the 
sacrament reception date, you can search the master data file by a specific sacrament date. To do 
this in the least confusing way, you click on the down arrow in the Select Index box. You can 
select the baptism date, communion date, marriage date, etc. If you select one of these dates, the 
data will be displayed in date order. It makes the most sense to click on the View menu, and 
select the sacrament that you selected the index date for. This will limit the data displayed to 
those master records which have had that particular sacrament entered. 
 
In the box labeled “Type the first few characters...” type in the complete date that you are 
looking for. If you are looking for Groundhog day in 1943, you would enter 02/02/1943. With 
dates, the program is not able to leap along toward the date you select until the entire date is 
entered. However, once it is entered, you should be able to browse all the people who received 
that sacrament that day (if it is more than one), and select from the names offered the one that 
you are looking for. If he or she is not present, then they were never entered in this master file. 
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When you are finished searching by sacrament date, it would be a good idea to set the index 
back to Name, which is called the primary index for the database, and is the index that people 
will normally want to try first. 
 
 Filtering the data 
 
In the paragraph above, you were instructed to go to the View menu and select a particular 
sacrament view. If you do this, and select Marriages Only from the View menu, then the 
database sets a “filter” on the data, so that the only data that display are the ones which have 
marriage details entered. If you have a very large database, this sort of filter can help you 
minimize your searching time, no matter whether you are searching by Name or by one of the 
sacrament dates. On the other hand, the search is so fast that most people will not need the 
filtering at all. 
 
Part 3. Creating Certificates and Reports 
 
Certificates and prepared reports are the true “output” from SacReg. In all cases, the certificates 
and reports are presented in the form of previews. Sometimes the ledger reports can be dozens 
or even hundreds of pages long. So the program gives you the chance to browse through the 
report on the preview screen. Only when you believe it is ready to be printed do you need to 
generate an actual paper copy. Many people can look up what they need in the preview, and they 
do not need to print the ledger reports out on paper at all.  
 
However, for people who do not like to preview what they are printing, and especially for 
people who are printing batches of certificates, there is an option, on the Miscellaneous tab of 
the Set Certificate Layout Options item on the Output menu. The last item can be checked to 
suppress the preview function altogether and go straight to the printer with whatever is being 
printed. 
 
 Generating Ledger Reports 
 
Ledger reports are reports showing all the data in the file for each person for any given 
sacrament reception. The concept of the ledger reports is that they can simulate a hard copy 
version of the data file. While this is NOT a workable backup of the master data files, it is a kind 
of backup, and it does give a snapshot of the data for a particular sacrament and time period. 
 
There is a ledger report for Baptisms, and a ledger report for Marriages, and so forth. There are 
different reports because each sacrament records different bits of information. To generate a 
ledger report, go to the Output menu and select the line that reads Print Ledgers, Labels, or a 
Group of Certificates. This displays a little screen that asks you to begin by defining a date range 
for your operation. If you are generating a ledger report, perhaps it is to be done annually. If so, 
you would enter January 1, 2003 in the top window (as 01/01/2003), and December 31, 2003 in 
the second window (as 12/31/2003).  
Next you would select the ledger that you want from the radio group in the center. If you want a 
baptism ledger, then you would select Baptism in this group. Then you would click on the 
button at the lower left which says Preview a Ledger. The Baptism ledger should pop up as a 
preview, permitting you to examine each and every page of the ledger report before printing the 
whole report. This report cannot be printed page by page. You either get the whole report, or 
nothing. 
 
 Generating parish notifications 
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Another valuable capability of your SacReg program is the generation of notification letters. 
From the Output menu, select Print a parish notification form. This displays a large and rather 
busy screen, carrying the text for Marriage notifications, Confirmation notifications, and First 
Communion notifications.  
 
At the top, the name and address of the parish to be notified must be entered. Next, you will 
select which of the three notifications you wish to preview or have printed. 
 
The text of all three notifications is displayed on this setup screen, so that you can customize the 
text if you wish. If you do customize it, and you wish to save it and use it all the time, you can 
do so with the third button from the left along the bottom of the screen, which says Save 
Changes to Text. If you wish to modify the text for one parish, and do not wish to save the 
changes, then simply do not click on the save button, but go ahead and preview or print your 
notification. If you don't save the changes, the next time you start the program it will have the 
default texts in place again. Even if you do save the changes, if you wish to “get rid” of the 
changes, you can click on the Restore Defaults button, and then click on the Save Changes to 
Text button. This will overwrite the old text with the default text. 
 
 Generating Certificates 
 
Making Certificates is the primary usable, visible output from SacReg, and there are several 
things to know. First of all, you can show a preview of a certificate for a given sacrament from 
the Output menu. But you must have the sacrament details entered for a person before you can 
preview his or her certificate. Each of the certificates can be printed in either the portrait or 
Landscape format, but the default is the portrait format. In fact, if you don't change anything, 
your certificates will print in black type, with no borders, and in the default font, in portrait 
orientation. When the data has been entered, you can preview the certificate to make sure it 
looks correct, all necessary fields filled in, etc., and then you can print it, right from the preview 
screen, by clicking on the little printer icon at the top. 
 
Two of the certificates are a bit more complicated than the others. A person will have either a 
Baptism certificate, or a Profession of Faith certificate, although either one might be at a 
different parish than the one entering SacReg data. The Baptism certificates, and also the 
Profession of Faith certificates, each have (or can have) notations which are to be printed at the 
bottom. These notations include first communion, confirmation, and other information which is 
deemed important to carry on the baptism certificate. If the information does not fit in one of 
the other fields, it can be entered in the remarks field. The first four lines of the remarks field 
will print on the notations part of the baptism or profession of faith certificates.  
 
If you elect to print these two certificates in Landscape mode, then all notations will be 
suppressed. If you want the notations suppressed in portrait mode, there is a miscellaneous 
option (Output | Set Certificate Layout Options | Miscellaneous) which allows you to elect to 
suppress the notations altogether. This same Miscellaneous screen, permits you to elect other 
options. You can suppress the horizontal rule on the certificates, and you can elect to change the 
date formats on certificates, to name just a few. 
 
 Generating Groups of Certificates 
 
If you have a first communion group, or a confirmation group, you can use SacReg to print a 
group of certificates, one for everyone in the group. This is done from the Print Ledgers, Labels, 
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or groups of certificates item on the Output menu. Having first entered the data for everyone in 
the group, you can select a date  range which applies to this group and this date only. Then you 
can select the first communion or confirmation item, and select print a group of certificates. 
Each certificate will preview, and you will hit print. Or, if you prefer to send the whole batch to 
the printer without previewing them, then use the miscellaneous options to suppress previews. 
 
 Certificate Layout Options 
 
SacReg is not a graphic layout program. It has some amazing capabilities in that area, but it is 
not intended for full blown artistic creation of original documents. Below are some of the things 
that can be added or changed or adjusted to help you get more of the look and feel that you 
want on your certificates. While this edition does not offer background or watermark images, it 
is certainly compatible with pages that might be preprinted with such a background or 
watermark, provided the images do not make the information on the certificate unreadable. 
Here are some of the things that can be changed. 
 
  Borders 
 
Border settings are another tab on the Set Certificate Layout Options screen. The default border 
is no border. You have the option of having a border or not. In fact, there are two borders, an 
outer border and an inner border. You can have one, or the other, or both. Further, you can 
have a full rectangular border around your certificate, or you can have a horizontal bar (or bars) 
on the top and bottom, or a vertical bar (or bars) on the left and right sides. And each border 
can be stepped along a little bit to move it further in or further out. You may find that the 
amount of possible movement is limited, but each can be moved. When you turn a border on, 
you need to go in and set the color for that border as well. Otherwise you will be turning on the 
border, to be printed in white, which would be like not having a border at all. Once you find 
border settings that you find pleasing, you can click on Save Settings, and these settings will 
become your default settings, each time you launch Sacramental Register. 
 
  Fonts 
 
The fonts used on the certificates can all be changed as to font, size, style, and color. Again, the 
basic layout is fixed, so you cannot print all the body copy in a 36 point headline size. So the 
font and size options have to be subdued enough to fit into the provided layout, which means 
you can move most things one or two sizes, but you can't change the basic layout by choosing 
wild variations. 
 
Fonts are another tab on that Set Certificate Layout Options screen.This screen permits you to 
set five different font settings for the five elements identified on the buttons, Headline, Parish 
Name and Address, body text, candidate text, and notations text. The options are limited only 
by the number and kind of fonts you have on your windows system. 
 
  Colors 
 
The borders, and the fonts, can be printed in colors other than black. Each font selection can 
have its own color, as can each border. To get color output, of course, you have to have a color 
printer connected to your system. 
 
  Text wording 
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All of the certificates have editable text. That means the user is able to change the wording on 
the certificates. The text is displayed in "editable fields" on the appropriate tab under Set 
Certificate Layout Options. Again, the format of the certificates is fixed, but within that format, 
it is now possible to customize the text used in printing any certificate. If you select a custom 
wording that you want to use every time, then simply save the settings, and the wording you save 
will be used every time you launch SacReg, until you change the text to be something else. 
 


